Macintosh Build Instructions

Build requirements

The following third-party tools/SDKs are needed to build PGP 6.5.1:

Metrowerks CodeWarrior Pro 4 (http://www.metrowerks.com)

Metrowerks CodeWarrior Pro 4.1 IDE 3.3 Update for MacOS
(ftp://ftp.metrowerks.com/pub/updates/CWPRO4/CW _Pro_4.1_IDE_3 .3_Patch.sit)
Metrowerks PowerPlant 1.9.3 Patch
(ftp://ftp.metrowerks.com/pub/updates/CWPRO4/PowerPlant_1.9.3.hqx)

Metrowerks CodeWarrior Pro 4.1 MacOS Compiler 2.2.1 & MSL 4.1.05 for Mac
(ftp://ftp.metrowerks.com/pub/updates/ CWPRO4/CW_Pro_4.1_Mac_Compiler_MSL..sit)

Metrowerks CodeWarrior MacOS PPC Linker 2.2.2 update
(ftp://ftp.metrowerks.com/pub/updates/CWPRO4/MacOS_PPC_Linker_2.2.2Updat.sit)

MindVision Installer VISE for Macintosh 6.0 (http://www.mindvision.com)

Apple Universal Interfaces & Libs 3.2
(ftp://ftp.apple.com/developer/Development_Kits/Interfaces-Libs_3.2_Update.sit.hqx)

Apple Open Transport 2.0.1 SDK (ftp://ftp.apple.com/developer/Development_Kits/OpenTransport/
0T2.0.1/0penTransportSDK.sea.hgx)

Aladdin Systems Stuffit Deluxe 5.1 (http://www.aladdinsys.com)

Unzip 5.32 (http://hotfiles.zdnet.com/c gi-bin/texis/swlib/mac/infomac.html?fcode=MC13934)

Apple DiskCopy 6.3.3 (http://download.info.apple.com/Apple_Support_Area/
Apple_Software_Updates/English-North_Amen'can/Macintosh/Utilities/
Disk_Copy/Disk_Copy_6.3.3.smi.bin)

Apple ResEdit 2.1.3 (CW Pro 4 Tools: Apple Development Tools:ResEdit 2.1.3.sit) or
Mathemaesthetics Resorcerer (http://www.mathemaesthetics.com)

Apple Appearance Manager SDK 1.0.3
(ftp://ftp.apple.com/developer/Development_Kits/Appearance_SDK_1 .0.3_v1.0.1.sit.hgx)

Apple Contextual Menu Manager SDK 1.0.3
(ftp://ftp.apple.com/developer/Development_Kits/ContextualMenuMgr_1.0.3.sit.hgx)

Stairways Software Internet Config 2.0.2 SDK
(ftp://ftp.quinn.echidna.id.au/Others/Quinn/Config/ICProgKit2.0.2.sit)

Preparing the build environment
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Install Metrowerks CodeWarrior Pro 4 (CW Pro 4) from the “CW Pro 4 Tools” CD. The “Full MacOS
Install” option will install all needed tools.

Apply the Metrowerks PowerPlant 1.9.3 Patch to update PowerPlant to version 1.9.3.

Apply the Metrowerks CodeWarrior IDE 3.3 Patch to update the IDE application to 3.3.

Apply the Metrowerks CodeWarrior Pro 4.1 MacOS Compiler 2.2.1 & MSL 4.1.05 for Mac package
to update the compiler and standard libraries.

Apply the Metrowerks CodeWarrior MacOS PPC Linker 2.2.2 update.

Install the Apple Universal Interfaces 3.2 into the CodeWarrior development hierarchy. Note that there
are multiple affected folders and the two hierarchies do not share the same folder names. When in
doubt about the location for a file to replace, search for the old file.

Install the Apple Open Transport 2.0.1 SDK into the CodeWarrior development hierarchy. Be sure to
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copy the Network Setup SDK into the CodeWarrior hierarchy as a peer to the Open Transport folder.
Note that there are multiple affected folders and the two hierarchies do not share the same folder names.
When in doubt about the location for a file to replace, search for the old file.

(8) Install the Stairways Software Internet Config 2.0.2 SDK. Place the file “InternetConfigLib” into
the folder “Metrowerks:Metrowerks Code Warrior:MacOS Support:Libraries:MacOS Common:”
and place the file “InternetConfig.h” into the folder “Metrowerks:Metrowerks CodeWarrior:MacOS
Support:Headers:Universal Headers:”.

(9) Delete the file “Metrowerks:Metrowerks CodeWarrior:CodeWarrior IDE 3.0” if it still exists.

(10) Increase the preferred memory size of the application “Metrowerks:Metrowerks
CodeWarrior:CodeWarrior IDE 3.3” to at least 25000K. Note that building PGP 6.5.1 can be memory
intensive. We recommend at least 64MB of available memory.

(11) Rebuild the MacHeaders precompiled headers. Open the CodeWarrior project file
“Metrowerks:Metrowerks Code Warrior:MacOS Support:MacHeaders:MacHeaders.mcp”, remove all
object code, and make all targets.

(12) Rebuild the PowerPlant precompiled headers. Open the CodeWarrior project
file “Metrowerks:Metrowerks CodeWarrior:MacOS Support:PowerPlant: PP Precompiled
Headers:PP_MacHeaders.mcp”, remove all object code, and make all targets.

(13) Install and personalize the MindVision Installer VISE 6.0 application.

Preparing the source code tree

Before compilation, several additional steps are needed to prepare the source tree:

(1) All of the binaries are located in the zip files of the name “binaresXXX.zip”. The common source
code has two such files (“binariesA.zip” and “binariesB.zip”) and the Macintosh source code has
three (“binaries1.zip”, “binaries2.zip”,and “binaries3.zip”). These files contain the binaries in a
“parallel” hierarchy to the source tree. Launch Unzip 5.32 and select the Modifiers->Extract
Options->Conversion Mode->Binary menu item to force Unzip to interpret all archive contents as
binary. Then, choose Extract from the File menu and extract the contents of the five binary zip files.
Note that Stuffit Deluxe can extract zip files, but is unable to automatically merge the files into the
source tree, so use Unzip if at all possible.

(2) All Macintosh-specific binary files are stored in AppleSingle format and end with the extension
« as”. These files need to be decoded into valid Macintosh binary files. An AppleScript has
been provided which uses Stuffit Deluxe to decode these files. To use this script, decode the
file “FixBinaries.script.bin” using Stuffit Deluxe. Open and execute the decoded script file
“FixBinaries.script”. You may be prompted for the location of the Stuffit Deluxe application. If so,
navigate to the folder containing Stuffit Deluxe and choose the Stuffit Deluxe application file. Each
time the script is run, it will prompt for a folder to “fix”. This script should be run five times, once each
for the “clients”, “libs”, “misc”, “install”’, and “docs” folders. The script can take a long time to execute,
so please be patient.

(3) Create the following empty folders:

e clients:pgp:mac:obj:
* install:pgp65mac:system:
» install:pgp65mac:system?2:

(4) PGPcontextmenu needs library files located in the Contextual Menu Manager SDK. Copy the
folder “Contextual Menu Manager SDK:Contextual Menu Development:Headers & Stubs:” to the
folder “clients:pgp:mac:PGPcontextmenu:”.
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(5) Copy the following files to the folder “install:pgp65mac:system:™:

«  CW Pro 4 Tools:System Folder Items:For MacOS Development:for Extensions
folder:ObjectSupportLib

«  Contextual Menu Manager SDK:Contextual Menu Development:Runtime: Put these in
Extensions f:SOMobjects™ for Mac OS

e Appearance SDK:Appearance

«  Appearance SDK:Appearance Extension

o Appearance SDK:Prefs for use with System 7.x: Appearance Preferences

(6) Copy the file “Appearance SDK:Keyboard” to the folder “install:pgp65mac:system:”. Rename the
resulting file “.Keyboard”.

(7) Copy the file “Appearance SDK:AppearanceCDEV” to the folder “install:pgp65mac:system2”.
Rename the resulting file “Appearance”.

(8) Copy the file “docs:builds:ds:PGPAdministratorsGuide.pdf” to the folder “install:pgp65mac:”.
Rename the resulting file “PGP Administrator’s Guide”.

(9) Copy the file “docs:builds:ds:PGPMacUsersGuide.pdf” to the folder “install:pgp65mac:”.Rename the
resulting file “PGP 6.5 User’s Guide”.

(10) Copy the file “docs:builds:common:IntrotoCrypto.pdf” to the folder “install:pgp65mac:”. Rename the
resulting file “Intro to Crypto”.

(11) Copy the folder “Installer VISE 6.0:Samples:Sample Projects:Installer VISE Headers:” to the
folder “clients:pgp:mac:install:”.

(12) Make the CW Pro 4 project “clients:pgp:mac:install:InstallAdmin Resource:Install Admin.prj”. This
will produce the output file “clients:pgp:mac:install:InstallAdmin Resource: Adminlnstaller.rsrc”.

(13) Use ResEdit or Resorcerer to copy the ‘ADMN’ 5000 resource
from the file “clients:pgp:mac:install:InstallAdmin Resource: AdminInstaller.rsrc”to the file
“install:pgp65mac:PGP65.vct”.

(14) Make the PPC target of the CW Pro 4 project “misc:mac:BuildTouch:BuildTouch.prj”. The
BuildTouch application is used to “touch-up” PGP modules by setting a common modification date,
removing source code control resources, etc.

Setting source code flags

The following library flags are located in the file “libs:pgpedk:priv:include:pgpSDKBuildFlags.h™:

e  PGP_RSA: Set to 1 for RSA-enabled builds

. PGP_RSA_KEYGEN: Set to 1 to allow RSA key generation

« PGP _USECAPIFORRSA:Set to 1to use Microsoft’s Crypto API (CAPI) for RSA operations. Always
set to 0 for Macintosh builds.

«  PGP_USECAPIFORMD?2:Set to 1 to use Microsoft’s Crypto API (CAPI) for MD2 hashing operations.
Always set to 0 for Macintosh builds.

« PGP_USEBSAFEFORRSA: Set to 1to use RSA’s BSAFE library for RSA operations. Note that
BSAFE is not included in these source code books.

«  PGP_USEPGPFORRSA: Set to 1 to use the PGP implementation for RSA operations.

«  PGP_USERSAREF: Set to 1 to use the RSAREF library for RSA operations. Note that RSAREF is
not included in these source code books.
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These flags should be set as follows for all three of the supported builds: PGP_RSA =
1, PGP_RSA_KEYGEN = 1, PGP_USECAPIFORRSA = 0, PGP_USECAPIFORMD?2 = 0,
PGP_USEBSAFEFORRSA =0, PGP_USEPGPFORRSA = 1, PGP_USERSAREF = 0.

The following client flags are located in the file “clients:pgp:shared:pgpBuildFlags.h”:

BETA: Set to O for release builds

PGP_DEMO: Set to O for regular builds

PGP_FREEWARE: Set to 1 when building PGPfreeware
PGP_BUSINESS_SECURITY: Set to 1 when building PGP Desktop Security
PGP_PERSONAL_PRIVACY: Set to 1 when building PGP for Personal Privacy
NO_RSA_KEYGEN: Set to 1 to disable RSA key generation
NO_RSA_OPERATIONS: Set to 1 to disable encrypting/signing with RSA keys

CREDIT_RSA_BSAFE: Set to 1 when building an RSA-enabled version which uses RSA’s BSAFE
library

These flags should be set as follows for the three supported builds:

Desktop Security: BETA =0,PGP_DEMO=0,PGP_FREEWARE =0, PGP_BUSINESS_SECURITY
= 1,PGP_PERSONAL_PRIVACY =0, NO_RSA_KEYGEN =0, NO_RSA_OPERATIONS =0,
CREDIT_RSA_BSAFE =0

Personal Privacy: BETA =0,PGP_DEMO=0,PGP_FREEWARE =0, PGP_BUSINESS_SECURITY
=0, PGP_PERSONAL_PRIVACY = 1, NO_RSA_KEYGEN =0, NO_RSA_OPERATIONS =0,
CREDIT_RSA_BSAFE =0

Freeware: BETA = 0, PGP_DEMO = 0, PGP_FREEWARE = 1, PGP_BUSINESS_SECURITY

=0, PGP_PERSONAL_PRIVACY =0, NO_RSA_KEYGEN =0, NO_RSA_OPERATIONS =0,
CREDIT_RSA_BSAFE =0

Building the code
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Open the CW project file “clients:pgp:mac:BuildPGP.prj”. Select the target “PPC” from the target
popup menu and make the project. This will build all PGP 6.5.1 client binaries into the folder
“clients:pgp:mac:obj:”. The PGPsdk library binaries are built into the folder “libs:pgpcdk:mac:pub:”.
Select all of the files in the folder “clients:pgp:mac:obj:” and drop their icons onto the application
“misc:mac:BuildTouch:BuildTouch”. The “BuildTouch” application will remove ‘mcvs’ resources
(an artifact of the build process at NAI) from the files and standardize the modification dates on the
dropped files.

Building the installer
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Copy all of the files/folders from ONE of the following folders to the folder “install:pgp65mac:”,
depending on the desired build:

» install:pgp65mac:Extras:business:
» install:pgp65mac:Extras:personal:

e install:pgp65mac:Extras:freeware:

Open the Installer VISE archive “install:pgp65mac:PGP65.vct”.
Select “Validate Paths” from the Extras menu. By default, all files in the archive will be located
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automatically. If a file cannot be found, you will be prompted for its location. Locate the correct file,
if needed.

(4) Select “Show Project Window” from the Archive menu. The project window contains a list of installer
build targets. The target with the bullet is the selected target and targets with a checkmark will be built.
Check and “bullet” the desired target by clicking in the columns to the left of the target names. Make
sure that only the desired target is checked.

(5) Select the “PGP 6.5” folder in the main VISE archive window and select “Set Icon Locations...” from
the Archive menu. Follow the directions to arrange the application in a presentable manner.

(6) Select “Build Installer...” from the File menu. This will build the installer into the folder
“install:pgp65mac:”.

(7) Use ResEdit or Resorcerer to copy all of the resources from the file “install:pgp65mac:Installerlcons”
to the built installer.

End of build instructions.
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